Learning Microsoft Excel 2019

Module 1 Contents

Chapter 1: Introduction to Microsoft Excel

Loading Microsoft EXcel ..o 1-1
The Microsoft Excel Screen..........ccccuieuiuriciniciniciniciceesecseenne. 1-2
MOVING the CUISOT ....c.cuviiriririecicieirrreceictes e 1-4
USing the MOUSE......cceurieueuieieiricicireeietreeicieeeseteeeie e seeeaenes 1-4
Using the Arrow Keys......c.coveeecueieininneccceeeeeerene e 1-4
Using the Scroll Bars..........coccviiiiniciniciniciniccccccees 1-5
Moving to Specific Cells ..o 1-7
The GO TO Command .........cccveueureeecrreeerninecireeeneeeeereeenenn. 1-7
Entering the Cell Reference.........ccoeovvvevcccereinnnencccrenenneneenes 1-8
Placing Labels on the Spreadsheet ..........ccccvvieinnicinnccnnicccnicnes 1-9
Closing the Spreadsheet ..o, 1-11
Entering Values into the Spreadsheet .........c.cccceevvnvcccennnncncnee 1-12
Entering Formulas into the Spreadsheet..........ccccoovceurnccinnccinecnees 1-14
Adding Labels to FOrmulas.........cccccoerurnineccerernnnccccieennecceenes 1-16
The Value of a Spreadsheet........cocceuvivceirncennccnccnccrecceeeens 1-17
Other Types of FOrmulas.........ccevvereecucueinnineccceienneneeceeeenenene 1-18
Saving the Spreadsheet .........cccoocviiiiiniciniciniiccccc, 1-21
Printing Spreadsheets ........c.ccccevrnncvcccninnncccercccceee 1-22
Gridlines and Headings........c.ccocccuvuvicurnecurenicrninicinnecnececnnn. 1-22
Page Setup ......coeeiviviiiiiic 1-22
Print Preview ..., 1-23
Erasing the Contents of a Cell .........ccooceureeinnecnncecnccreccneenens 1-24
Spreadsheets EXercise 1-1.....coveeeueueeeeeierininininerissisieieieeeie e 1-26
Spreadsheets EXercise 1-2......cccvvivieeueueurininineeeieieieiseseseeseiesesesseene 1-29
Spreadsheets Assignment L........ccccovevverruenruenninscnscnsncnsncnsnennnes 1-30

© Guided Computer Tutorials, 2018

C-1



Learning Microsoft Excel 2019

Chapter 2: Formatting Cells

Formatting Single Cells .........cccoeeeirrinincecirrcccceeccenenne 2-2
Formatting Groups of Cells ..........cccocvieiiniiininininininicnicccces 2-2
Formatting Values to CUITENCY ....c.covvevcueuerrininiieccieieieeeecerenenen. 2-4
Formatting Values to Per Cent .........cccccvuveerrenierrnicrninecrrineciennecnennes 2-6
Changing Column Widths........ccceevivicinnnniccceencccrenenn. 2-6
Entering the Required Width ........cccovvveciiinncciieaes 2-7
Manually Adjusting Column Widths ........c.ccccevvvinicccinininnnncs 2-9
Automatic Column Widths .......cocceuvveiiniiniicinccaes 2-10
Approaches for Entering Spreadsheets.........ccococevvceirenccrnenccunnncnen 2-12
Starting a New WOorkbooK..........coevveveccuerninnenencccreenncccnes 2-12
Adjusting Column Widths.........cccoiiiiiiiiiiiiiicnis 2-12
Entering the Labels and Values of the Spreadsheet ................. 2-13
Entering the FOrmulas.......c.ccocccvvecurnecnnicnnicenecenecenenes 2-13
WIQP TEXL ittt 2-14
Formatting Non-Adjacent Cells........c.ccovereveeeuernnnnncrcccnnnnns 2-16
Underlining Using Borders..........cccccoeevnninevcceennnencccnenennes 2-18
Entering the Main Headings........cccccceevvnncrccecnnnncncccncnnne 2-20
Centring Across Selection.........c.cccuvieuvirivciniccinecinecicnicneenn. 2-20
Setting the Font, Sizes and Colours.........c.ccoveeevcccrerrinnenccacnes 2-22
Adjusting the Row Height........cccvvcueinciinnccnccnccnicceaes 2-23
Checking the Spreadsheet..........ccocoveececereininnncncccrerrncccnes 2-24
Saving and Printing..........cccccocecvicnicniniinicniccccne 2-24
Spreadsheets Assignment 2..........cooveevreinneinnennneenneesnecssecsnnes 2-26

Chapter 3: Further Formatting

Formatting the Values..........ccccoeeernnnicccnrcccceeeseccceeene 3-1
Formatting the Table Headings ..........ccccooeeiviiiininiciiiniciiiiciciicnnes 3-2
Formatting the Main Heading.........cocoeeeeeeirinnnnccccinrnnccccceennen, 3-5
The Format Painter TOOL.........cceveeinicueinicieiniceniceeeenecieeneenennes 3-6
Adding BOrders .......ccccceueirninnciceinrniecccienreeeeeeese e 3-7

Using the Borders ICom......c.ooceuvceinicecrrinceirecreeceeccneeeeene. 3-7

The Draw Border Tool..........cccccviiiiiiciniiiiiciiccnccen, 3-9

© Guided Computer Tutorials, 2018



Contents

Fll COLOUTS.....viiniiiieirireecciete ettt 3-13
Column WIdEhs .....c.ccueuririrecieirrecccrreec et 3-14
Saving and Printing.........cceceeeeveerninicrninecinnicreneceneeeseeseneeeeens 3-14
Spreadsheets EXercise 3 .......cooveueueueueieecceienineneinenieseeseeeeeenenne 3-15
Printing FOrmulas ..........coocvceueueinnnnccccennccceieeseseecee e 3-16
Spreadsheets Assignment 3 ........ccoccevvveiiieinnecnnecnnecnneeineesnnes 3-19

Chapter 4: Copying Cell Data

1) 2T S 4-1
FIll DOWIL.c..ctiiiiicieitcictseciecieeeie ettt se e eeacsessaesenns 4-2
AULORIL ... 4-3
AULOfIl]l OPLIONS ... 4-5
Fill SETIES ..o 4-5
Filling Common Jtems ........cccceeueueiririnineceieieierereeccieieieseeeecseneeene 4-6
Clearing Cells With Autofill.........cccvveeurnecinicirricerecrrecerecieenes 4-8
FLash Fill ..o 4-9
Loading the Prepared Workbook...........cccccccuveuiivcinicinicincinicnnne. 4-9
Extracting Data ..o 4-10
Combining Data......c.ccccvuciiuiiciniciiiiice e 4-13
Absolute and Relative Cell References...........cccccoeuveeceiviniciviccnnenee. 4-14
Loading the Prepared Workbook ........cccocccevecuviniccrnnicucnncncs 4-15
Entering the Formulas.......c.ccocovevcccennnnnncicccnrnnccccennne 4-15
The Grocery Store Template .........cceeverererceereiennenecccieenseeeaenes 4-18
Opening the Prepared WorkbooKk..........cccoeeuvevecccreinininincccnes 4-18
Autofilling the Month Headings .........ccccoveveveccueinnnencnccncnnnes 4-18
Entering the Month Formulas........ccccccovviicciinnnnnccccnnne, 4-19
Copying the Formulas........cccceevnnncvccennnccceerneccenes 4-20
Adding Borders .........cceuvevceunenceeinicieincencenecieneeieeeneneaes 4-21
Entering the Totals Formula........ccccoeevnnncvccennnnnccccnnne 4-24
Saving and Printing..........ccccocccvcnninincnicniccccn, 4-25
Making Some Changes.........c.coceeeceeveurnnenecreererenineneccenenennes 4-25
Spreadsheets Assignment 4..........ccouevveerneenieenieenneenneenneennnees 4-26

© Guided Computer Tutorials 2018

G3



Learning Microsoft Excel 2019

Chapter 5: Rearranging Data

Loading The Prepared Template .........cococeecueueurrnencccernnneeccecnennn. 5-1
Saving the Document ... 5-1
Inserting ROWS 01 COlUMNS ......c.coeuririiicecereiririiccciceiee e 5-2
Editing Cell CONENtS........couveueueiriereiriereiicieiiereicieeseeseeseeesessesesennes 5-6
SOIEING ..cviiiiiiiic s 5-8

Sorting on Labels........coveeeiinnrccccrccccereccen, 5-8

Sorting on ValUues ... 5-9
Spreadsheets Assignment 5........ccccovevvuerieensenscnscnncnsennensnenanes 5-11

Chapter 6: Using Worksheets

Loading a Prepared File.........ccccoviiinicnncnccerecerecicnecnennes 6-1
Saving the Workbook..........ccccccoceuiinniniicccircccce e, 6-1
Naming @ WOrksheet ........c.ccocceveeiniciniccinieenceeceecieseenennes 6-2
Copying Data to a New Worksheet.........cccccevvnicccinnnnncccrcnennnn. 6-3
Changing the Data in the New Worksheet .........ccccccevrnnnncccunnnne. 6-5
Copying @ WOTrKSheet........c.ouvcueurivcueiriceirieciriiciriccieeneesseneeceeeseeseenes 6-6
Moving @ WOrKSheet ..o 6-8
Changing the Sheet Tabs Displayed..........ccccocoevirinciniccnicininncnicnnee. 6-9
Moving Through Worksheets .........c.cccoovveeevccrernnnncncccrererneceenes 6-10
Deleting WOTKSheets .........ccveueureneueiniceiniceinicereceeeeeessecaeneeenens 6-11
Setting Tab ColoUrs........oveeceueirirniiccicerrccceeeeee e 6-12
The EQuation DUMP ...c.c.cueuiiririiiicieirrcceieesceceie e 6-13

Copying @ WOrksheet .........ccccoeeuvrveecccreininnecccreeeneecaenes 6-13

Turning on the Formulas .........cococoeeueinnnnncncccnnnncccene 6-14

Turning on the Headings and Gridlines...........ccccccocccvuviinnnnes 6-15
Spreadsheets Assignment 6..........covuevieinneenseennecnseennecnneennnes 6-16

© Guided Computer Tutorials, 2018



Contents

Chapter 7: Displaying Data in Charts

Loading the Spreadsheet ..........cccceurrnnicccinnnccccerccein,
Creating a Pie Chart ...
The Chart ICONS .....c.ccciiiiiiiiiciiccccee e
Setting the Chart Title ......c.occccvieirccrccrcreceeceeceeeenes
The Chart Location ..o
Looking at The Chart......eeeiseienseseiessesssessessessssssssssane
Adjusting the Size of the Chart........ccocccevceincenrcercerecerecenes
Adjusting the Chart Values .........cccevvrvevccciennnccccerreeccceen.
The Chart EIEments.........cceveeueuniereinicreinicieinicreineceeeseesessesesesseesennes

Adjusting the Chart Title ......c.ccoovreveveeeenrnccccerrreeeeaen

Adjusting the Chart Area........ccoccvicivinicinicinicininicnicccnes 7

Adjusting the Legend.........c.ccovrvveccernnnnencccrennncccenenns 7
Changing the Chart TYPe. ..o 7
Exploding a Slice from the Pie Chart ........ccccoeevnnieccccennnncccnes 7
Changing Slice Patterns.......c.coceueurirerecececirinininececieieseseeeseseeeeeseene 7
Looking at Other Chart TYpes.......cccoevurveeceereinirinicccreeenccenes 7
Printing Charts ......c.ccevrrecceienrnccccerseeceeieee e 7
Deleting a Chart .......ccccoiiiviiiiiiiicccc s 7
Spreadsheets Assignment 7........cocevevvuersuensuenscnscnsecnsnensnenssesnnes 7

Chapter 8: More Detailed Charts

Recommending @ Chart ........c.coeeuveernenecinienncceeeeecsenseenennes
The Column Chart OPtions.........c.ccceevererereririrrenirerieeieeeeeeeeeseeene
The Chart Title ..c.coveeiricccrcccce e,
Moving the Legend ..........cooveeeeeinirnniccceiiinrecccreneeeeeeaes
The AXiS TItleS ....cuvvireiiecicrcce e
Data Labels.....c.ccceurieeiniccinicercicnec e
Data Table ..o
Setting the Chart Location.........cccccuviecinicinicininiciccccscces

© Guided Computer Tutorials 2018



Learning Microsoft Excel 2019

Looking at the Column Chart .........ccccoccviciniiininincnicncccces 8-9
The Column Chart Elements..........ccccocceuvieivinicininicrniicinienenn. 8-9
Changing the POt ..o, 8-10
Changing the Axes FOrmat........ccocoeeeecceueininnncncccrerninnccenes 8-11
Altering Colummn Effects .......covveveeucuennnncncccenrneccceenes 8-13
Altering Background Textures .........cccoevvevevecucuernnnencccnenennns 8-15
Looking at Other Bar and Column Charts.......c.ccccovevecucucnnene. 8-16

Line Charts......ccocciiiiiiiiciiccc s 8-18
Inserting @ Line Chart .......ccovveveveceiennencnccccerreneccceeneens 8-18
Altering Line FOrmats .........ccccuvieuvininiinincinicinieicsiesccnciennes 8-19
Changing the AXis Scales.......c.coovvverecerernnnneccceeeseccenes 8-21

Other Charts ..ottt eseaens 8-22

Looking at the Charts .........ceeeeeeeeeerinnnicccesccccreeeeeeeenes 8-23

Comparing Valtes.........cccuveeurenecrrinicrniicienecreneesesseeessesesensesesens 8-24

Filtering Chart Data.........cccccceeueurirninecceinreccceeeeceeneneeeee 8-26

Spreadsheets Assignment 8.........ccevveirneinneinnecnieennecnneennees 8-28

Chapter 9: Sparklines, Maps and Quick Analysis

Loading the Spreadsheet ... 9-1
Inserting Sparkline Charts .........c.ccocoveeececeennnencccceeeecceeenene 9-1
Formatting Sparkline Charts ..........ccccoooeiiciniiininincnicnccccces 9-3
The Sparkline Styles.......c.covveveccceriirinnnccccierrecccree e 9-3
The Sparkline Options.........ccceceueueueurinenenecrcieierinereeeeree e 9-4
Sparkline TYPEs ......ccvuvevereeucreuriniriccereirreccees e 9-5
Changing the Data ......c.coveeveeeicieinnccceeseee et 9-6
Copying Sparkline Charts..........coccveeeurenecinineeinineceneceeneceeseeneenes 9-8
Quick Analysis TOOIS ......coveeueueueieiririecccerr e 9-9
Creating Map Charts ..o 9-10
Loading the Spreadsheet..........cccccccueurnnnnccccnnnnccccne 9-10
Creating the Map Chart ..o, 9-11
Spreadsheets Assignment 9..........cooveevveiiiernnernnennnennneesnensnaees 9-14

© Guided Computer Tutorials, 2018



Contents

Chapter 10: The Drawing Tools

Opening the Prepared Template .........cccccoevvnencccennnnnencccreirenene 10-1
Creating the LOZ0......cccceuiiiciniciniiisicccccccc e 10-2
Inserting a Text BOX......ccoviiininiiiininiiciiicciicccincce 10-2
Adjusting the Text Box Shading..........cccoeveveeinvcvinnccninccnnenes 10-3
Centring the TeXt.....c.covicieeirirccereccee e 10-5
IMporting Graphics........ooveeceueurrinenerceeeenrreeeceeseseeeese e 10-6
Setting the Graphics Properties..........ccoevecurerecrrineceeinencrenecucnnencnens 10-9
Magnifying the SCreen ...t 10-11
Printing the Spreadsheet ..........cccoccviiiviiiniicncinicicicienes 10-12
The Shape TOOIS .....covvuririeieieieieieeeee e 10-12
Creating Shapes ..o 10-12
Inserting Word ATt ......cccceuernnicccreininnieccceneeseeeeenenens 10-16
Adding Text to Shapes.......ccevcueureeeirecrerrieerrenecreeeneeeaens 10-18
Fill EffECtS ..ot 10-21
Inserting ICONS ..o 10-25
The Draw Tab......ccccoiiiiiiiiiiicic s 10-26
Pens and Highlighter.........c.coovereiinnnncccnnnnecccee, 10-26
INK t0 Shape .....coviiiiiiciciiirccce s 10-28
Ink t0 Math ..o 10-29
Spreadsheets Assignment 10..........coceevvuenruensuensnensnensnensensnennnees 10-30

Module 1 Project

EasyTune ..o P1-1

© Guided Computer Tutorials 2018

Cc-7



Learning Microsoft Excel 2019

Module 2 Contents

Chapter 11: Making Predictions With Excel

The Motel TemPlate ......cceuvueeeueuiueieiiecceererrree e 11-1
Loading the Template........cccocceurinicrrinecrrnicirrecrnecenecienenes 11-1
Calculating the Income From Rooms..........ccceeeccucuerninninccncnes 11-1
Calculating the Income From Food.........cccoccvnicininicrnnccnne. 11-2
Calculating the Total Daily Income.......cccceevveveecccrerninnincccnes 11-3
Using the Spreadsheet to Make Predictions..........cococeccueunnee. 11-3

Adjusting the Motel Template .......c.ccoveueurevceeinncrenenceeneeneccneeeens 11-5

The Goal Seek Command .........ccocceuveeirineernincericeeeseeeeens 11-8

Applying the Goal Seek Command ............cceeuvivcuiivcinicininincnicnnes 11-10

Spreadsheets EXercise 11 .......coovviviviriririeieieieieieeieeeeeeeeeseseseens 11-11

Spreadsheets Assignment 11.........ccocevvuenvuensuensnensnensnensnensnecnees 11-12

Chapter 12: Making Decisions With Excel

The IF Command.........ccccceuviiiiniininiiiicccecce s 12-2
Greater Than or EQUal TO....c.ccueuirnnccccrrccccceeeceeeee 12-5
EXErcise 12-1 ..ot 12-6
Completing the Template.........cccovevereccrerrnnenercccreeenecenes 12-6
Displaying the Formulas Used. ...........cccoocoeuviiininncniccinicinicnnes 12-8
AND and OR ... seans 12-10
AND (2,D) v 12-10
OR (2,D) sttt 12-12
EXErcise 12-2 ..o 12-14
Conditional Formatting.........c.cccoevvveeeceeirnnineccreienneeccenenenene 12-16
Setting a Conditional Format.........ccccccocueurunnncncrccriinnnnccnes 12-16
Changing Values.........cccoveveeiierninininiccceineccceeeeeeeaes 12-17
Adding Another Conditional Format .........cccccoeveeuvvnicrnunnee. 12-18
Removing Conditional Formats...........ccccoeuecuvieuniciniunincunicnnes 12-18
Spreadsheets Assignment 12.........ccoceveevuenrecnrucnsncnsecnscnsncnnens 12-19

© Guided Computer Tutorials, 2018



Contents

Chapter 13: Lookup Commands

Interest Rate Calculations ...........ccoeeveeeieecieenieeeeeseeseee e 13-1
Loading the Template........cccocceurinicurinecirinicirinceneceeceneaes 13-1
Calculating the Interest Due........ccooeeeceuerririnnecccrenninniecenes 13-2

Income Tax Calculations..........ccccueeeeeeeeeieieieeeeeeeeeeeeeeeree e 13-4
Loading the Template ......c.ccccovveveceeinnnniccccerrcccienennes 13-4
The Base Tax Calculation ...........ccceveeveieeeieieeereeeeeeeeeeeeeenns 13-5
The On Income Calculation ..........ccccueveeveerreinieenieenieeeeeienns 13-5
The Extra Income Calculation............coeeveveeveeereenieeeieeeieeenenns 13-6
The Tax Rate Calculation ..........ccceeeeveeeveiereeereeeeeeeeeereeenenees 13-6
The Extra Tax Calculation..........ccceeeveeeeeeeieesieeeeeecieeeeeeenns 13-7
The Total Tax Calculation ..........c.ccoveeveeeveiereeereeeeeereeeeeenenn, 13-7
The Net Income Calculation...........ccceveeveeereenieenieeeeeeeeeeenn, 13-8
Using the Tax Table........cccccvverrnicinncincreceeceeceeaes 13-8
The EQUation DUMP ....ovevvveueeeeiiciciccccserteeeeeeeeene 13-9

Spreadsheets Assignment 13........cccccevuivieiiinininenincnnecnsecnnns 13-11

© Guided Computer Tutorials 2018 c-9



Learning Microsoft Excel 2019

Chapter 14: Creating Sales Invoices

Entering the Labels of the Invoice.........cocoeeeeeuiirnnncncccierrccee 14-1
Adding BOrders ........ccceuveveeeinecueinieieinicenicieseereneceeseeseseseseseeeaens 14-2
Creating the Company Title ..........cooeeeeerrnnncrcccrrrrecccceenee 14-3
Entering the Calculations...........cccococuviiiiniiniciniiiccnccnee 14-5
Initial SEttNGS....c.evvvreeeerereirirrrecccee e 14-5
Calculating the Amount.........cccccvicvinininicncncccn, 14-5
Turning Zero Values Off .........cccccceveennnnncnccennnncccenenes 14-6
Calculating the Sub-Total .........cccovvicuriccirnicrcececcnen, 14-7
Calculating the GST ..o 14-8
Calculating the Overall Total.........ccocoeoeueuiirnnnrcccieeccnee 14-8
Inserting Today’s Date ........ccoccurereecurenecerinecirenecerneceenecneenenes 14-9
Checking the INVOICe ......ccceueueverriririccicieieirecceree e 14-10
Using the INVOICe.......ccoviiiiiiiiiiiciriicccces 14-10
Adding an Inventory to the INVOice........coceeeeuevriririneccrcreirirreccaes 14-10
Loading the Template ........ccocceurieceinincerninccinccrecceicecnenes 14-10
Looking up the Description........ccccceuervnenccccrnnnnencccnennn 14-11
Looking up the Unit Price........ccocceuvveernnccinnecrnrccriccinnes 14-12
Setting the Blank INVOICe .......cccevruvireccccernininccccieieccaes 14-13
Setting the Print Area........cccccevrvnevcccieininnccceeeeeeeaes 14-14
Saving as a Read-Only File ......cccooouveieciinnccccicees 14-14
Using the Stock INVENtOry......ooveevevevririnenencceceeieirnenecceeenes 14-15
EXercise 14-1 ... 14-16
Loading the INVOICe .......cccevrurrinieccieieirrecccceereeeeceens 14-16
Naming the Stock Table ........ccccccccniiniiininiiicicinice, 14-16
Looking up the Description.........ccccceueurnnencccrcrnnnnencccnennn 14-17
Looking up the Unit Price........ccocceuvveerninccinnccrnccirirccnnnes 14-18
Turning Off Zero Values ........ccccceeveirinnnencccennnnecccnenens 14-19
Calculating the Amount and Sub-Total .........ccccceuiurnnnennes 14-19
Calculating the GST ..o 14-21
Calculating the Total.......cococoeeuerirnnrcecerreccceeeeeaes 14-22
Setting the Print Area ... 14-22
Data Validation........cccveeeuviieiniccinicericeiseeeceeeeenenes 14-23
Saving as a Read-only File.........cccccooeviiiniiininininicinicicnn, 14-26
Using the INVOICE......cccoceueveieirericccieierreccccee e 14-27
Displaying the Formulas........cccocceuvveernnccinnccnccniccnnenes 14-27
Spreadsheets Assignment 14.........ccccevvveivnveiniveenneennsennnecsssennnns 14-29

© Guided Computer Tutorials, 2018



Contents

Chapter 15: Sharing Data Between Files

Naming Single Cells........ccovmrrieennnrccceerrccccree e 15-1
Entering Formulas Using Names .........c.coocceurenererrereernineernencnereenenens 15-3
Naming Groups of Cells........coouveeererrrninirenccreirrreccceeeeeeenes 15-4
Loading the Template........cccocceuvnicurnecrnnicieceneceeceeeaes 15-4
Naming the Cells.......ccooeeceeuiirinnniiiiccceecceenns 15-4
Entering the Formula ..o 15-6
Another Advantage of Named Cells.......c.cccoeuvvereirncreinnccnnccenecnee 15-7
Deleting NAMES ......ccccoeeueueuieririiccieieieireseeeeierereeseseesesesese e eseeseaenes 15-8
Linking Spreadsheets...........ccccocuniiininiiinicciniciiecsicsiceeeienaes 15-8
Loading the Outdoors Template .........ccocoeeeveecreurnnnenccecnenennes 15-9
Entering the Formulas.........cccccociininicicis 15-9
Naming the Cells.......ccooevceeininnnecceirccceereecenes 15-11
Setting up the Home Department File .......cccccccvvecirnicrnnccrnnncnce 15-12
Setting up the Electrical Department File........cccccevuvnninccennnnnnne. 15-13
The Dependent Spreadsheet .........c.cocevvvevcceeinnnncrccceerecnes 15-14
Loading the Office Template.........cccouveueurrceurinccrrnccrencecnnenes 15-14
The Net Profit Formula .......ccccoeeeiviieincciccrcceccnes 15-14
The Percentage Profit Formula........c..ccccvioiiniiniinincnnns 15-15
The Totals Formula ........ccccovveeiniininicnccccericeecenes 15-16
Linking the Spreadsheets ...........cccoccviiviuicciniccinicininicnicnnes 15-16
Changing Values in a Support Spreadsheet ........c.ccccovvvccvcuennnee. 15-18
Looking at all the Files........ccocceerinicnnicnncrneceneceecneeeens 15-19
Spreadsheets Assignment 15........cccccvveiinveinnrenninecnnseninsecsssennns 15-21

Chapter 16: Using Macros and Buttons

Using a Simple Discount Table.........ccccovvvecereinnnncccenrneccenee 16-1
Opening a Sample File.......cccoovieunnvcnnicnncrcenccrccnn, 16-1
Setting a 5% Discount Macro .........cccevueeevninieccininiccinnnccens 16-1
Setting a 10% Discount Macro ..........cccoeeveveieveciccccciiine 16-4
Setting a No Discount Macro ..........cceveecininiicininiccciniineccnns 16-5
USINg the MaCTOS ......cecuieucurieicrriiecieieeieieecieeecseeesereeeecneseaes 16-6

Saving the File as a Macro-Enabled File........c.cccccoeunnnnncccnnnnnnne. 16-7

© Guided Computer Tutorials 2018



Learning Microsoft Excel 2019

Assigning Buttons to Represent Macros ... 16-8
Drawing the Shape........ccccovnvcinnccceernccccns 16-8
Formatting the Shape ... 16-8
Setting the Button Properties .........c.ccccoeevurnneccccrenninnincnccnes 16-9
Assigning a Macro to the Shape.......c.cooovvvvccccnnnncnccnnne. 16-10
Adding Buttons for the Other Macros ........c.cccoeeveucurenccureenee 16-11

Other Macros and BUttons...........ccveeueueeeerreeerneneereeniereeeenenenens 16-14
The New Items Macro and Button........c..cccveeecurenccrrenccnnnnee 16-14
The Sort Items Macro and Button..........c.cecececeecuernnencccnnne 16-19

Looking at the Macro Steps........c.cccuvueuiurineirincinicineeicsicsiensiennes 16-23

Deleting @ MaCTO ......cccueueueuririnieecicreieiriececierete e seecaereseseseeseeseaes 16-24

The Developer Tab ... 16-25

Spreadsheets Assignment 16..........cccceveiereiiiernneennernssecsssennnns 16-27

Chapter 17: Payroll Systems

Loading the Payroll Template.........ccccoovvverecereinninneccceerrccnes 17-1
Completing the Payroll Worksheet.........c.ccoovcurnvcennccnnccnncnees 17-1
The Tax Calculation ..........cccveeiviieinicciriccccceee e 17-3
Calculating the Net Pay ..o, 17-4
Printing the Payroll........ccoococcincccirccceereeeceeeenne 17-4
The Pay Advice Worksheet........cocceurieueurinceininereiniccncereceneeeeens 17-5
Naming the Payroll Cells..........cocoececeueurnnnniccenrncccennne 17-5
Sorting The Payroll ..o 17-6
Completing the Name Section of the Pay Advice.................... 17-7
Completing the Pay Advice Table........cccccevvnncccrinnnnccnes 17-9
Completing the Superannuation Section..........ccoecuevrevcucunenee 17-11
Printing the First Pay Advice.......ccccoevurnnncrcccnnnnecccenne 17-12
Printing the Pay Advice for Other Employees........................ 17-12
Using the Payroll System .......ocoococcuevrirninenccereirirreccicreieeseeeenes 17-13
Adding Macros and BUttONS ........ccceuecueurecurineceeinicininecreccneneaens 17-14
The first Employee Macro ........cccceeeueururninencccrereirnenecccnenens 17-14
Setting @ Button ........cooiiiviiiiiiiccce 17-15
Creating Buttons for the Other 3 Employees .........ccccoceeuuneeee 17-17
The 3 Remaining Employee Macros..........ccccoeueurernenenccecenne 17-18
Saving the File as a Macro-Enabled Workbook..................... 17-18
Spreadsheets Assignment 17..........cocevveevreinrucnrecnsecnsecnscnsncnnens 17-19

C-12 © Guided Computer Tutorials, 2018



Contents

Chapter 18: Financial Applications

Personal Banking .........ccovveoceuennnncncccinnnecccicesseeeeeeeeeene 18-1
Opening the Prepared Template .......c.ccocccvvicurnecrrnecrnenccnnnn. 18-1
Completing the FOrmulas ........c.ccoeeveeecccerninnnenccerenninneeccnes 18-1
Using the Personal Finances File ........cccococcvnccvniccinniccnnnenes 18-3

The Home Loan Simulator..........ccccceevrniccceininnncccceeencceenes 18-3
Opening the Prepared Template ........c.cccevvvnercccreinnnnccnenes 18-4
Entering the Initial Values .........cccccccoeevniniccccnnnncccennnes 18-4
Naming the Cells.......ocoveeeeirinnreccercccereeeceees 18-5
Calculating the Monthly Interest..........cccccovecinicinicincnincininnnn. 18-5
Calculating the Number of Repayments .........ccccccceueurenenecucnes 18-6
Setting the Monthly Repayment ..........cccccovucuniiiniiininincnnnn. 18-6
Completing the Months Column.........cccceeurvvercccrerninenncccnes 18-8
The Start Balance Column .......c.oocccuvveeirinicinnecinnicereceeenes 18-9
The End Balance Colummn ........cccccceeueurinnnenccccrninnnecccnenen 18-10
Turning Zero Values Off ........cccooeoeeeirnnnncccccnrnccceene 18-11
The Monthly Payment Column.......c.cccovveecccrnrnnincccnnens 18-11
The Principal Remaining Column.........coceeeeeueueurnnenenccecnnne 18-12
The Total Paid Colum .....c.ccocueuricueinicciriciciriccrecieeeceenenes 18-12
Completing the Start Balance Column ........cccoceeccucvevrunenencnnes 18-13
Adding a Border After Each Year.......cocccoevvccnnccrnnccrnenence 18-15
Using the SImulator .......c.cccevivcvccninnnnccccerreecccenens 18-16

Spreadsheets Assignment 18.........ccccceveivneinieinieinisecnnecnnecnnns 18-17

Chapter 19: Date Calculations

Creating a Library Book Overdue System .........cccccevvnicccrnurnnnnee. 19-1

Opening the Prepared Template .........cccccoevvnencccrennnencnccceinnenene 19-1

Naming the BooK LiSt.........cccccvieuiiiininininicniciiccsicsicescncenes 19-2

Looking up the Book Title and Author........c.cccevvveecccennnccnes 19-3

Calculating the Return Date..........cccccvieeuniciiiniiiicnicccncn, 19-4

The Overdue Calculation ..........ccccceuvieeiriccinicciriccceceens 19-5

Filling the FOrmulas..........ccococceuivecinnicininicnnicreeceeceseceeneeenens 19-6

Using the Library System ........cccccccceurnirnirccccrernnnccccieeeeneeceenes 19-7

Creating the Equation DUMP .......ccoveveeuiirinnnencccieenreccceeeene 19-8

Spreadsheets Assignment 19........cccccevveivneinneinnecnnecnnecnnecsnnees 19-9

© Guided Computer Tutorials 2018



Learning Microsoft Excel 2019

Chapter 20: Pivot Tab.les

Loading the Prepared Data .........ccccceuvuverinerccereinininccccieessceenenes 20-1
Creating @ Pivot Table........cccceiiinnccireccccerreeccceeeee 20-2
Setting Up the Pivot Table........cccovveveceiirnnccceercccnes 20-2
Inserting the Rows, Columns and Data..........ccccevvnencccncnnnne. 20-3
Formatting Pivot Tables.........ccccvvnivcciinnnccccnneccceenee 20-5
Pivot Table Styles........cccceeriincccieinrcccceerecceens 20-5
General FOrmatting ........c.ccccceeveivininercccrerninnicccereeeneecaenes 20-6
Editing the Pivot Table..........ccccoouoeuiiiiiiiiciiciicincnceccces 20-9
Adding Extra Fields ........cccocviniiininiinicicicccsicccceaes 20-9
The Field Options........coceureeeuricecinincernicenieesseeeeseeeeennenes 20-10
Turning Sub-Totals Off.........cccceveeirienccrccrccrccines 20-12
Changing the Calculation ........c.coveveeceeueinnnnccccereeeaes 20-13
PIVOt CRATTS.....eecviiecieiicieirce e neane 20-15
TIMEINES ..o 20-17
Loading the Prepared File........ccccccceeuninnnncccnnnncccnne 20-17
Inserting a Recommended Pivot Table ........ccccccevvnencccnnnne. 20-17
Using the Timeline.......ccccoeovvnrinevceeininnniccceersnecceeenens 20-19
Spreadsheets Assignment 20.........cccceeveirneinnseeniecnssecnssecessenenns 20-22

Chapter 21: Useful Tools

The Save OPtioNS......cceuecueiricreirieieirieiereeeeere et seeaeaens 21-1
Conditional FOrmatting.........ccceveeurerierrirecinnicreneceeneeesneeneneeenens 21-4
Data Bars ... 21-4
Conditional Formatting Rules........c.cccccoeeurnnnncccinnnncccnes 21-5
Style and Table FOrmats.......c.ccceerverececeereirnineecceeiereseseeeneveeeeenene 21-9
CUSTOIM SEYLES.. ettt 21-12
The Currency BUtton ......c.ceeveecccieriininiiccereieesececiereseeeeeeeaes 21-15
Filtering With Table SLicers.......c.ccoovvecerinnnnecccrrcccieeinen, 21-16
Creating the Table ........ccccociveiiiiininniccecccecaes 21-16
Inserting the SHCers ........coviiiciniciniiiciccccccae 21-17
Using the SHCeTs ........ccviiiiuiiciniciicisiccccccas 21-18
Spell ChecKing ... eeaens 21-20
Using Touch MOde......cccueuririniicciciciiriecccieieieeeececieieie e 21-20
Using TemPIates.......coccueueueueuririreceicreieinineeciciereieeseseeeaeseseseteeseesenes 21-22
Module 2 Project
Quantum Electronics.......oouoviviiieieieecieieeeeceeeeeesee e P2-1

C-14 © Guided Computer Tutorials, 2018



	Introduction to Microsoft Excel
	Loading Microsoft Excel
	The Microsoft Excel Screen
	Moving the Cursor
	A	Using the Mouse
	B  	Using the Arrow Keys
	C	Using the Scroll Bars

	Moving to Specific Cells
	A	The GO TO Command
	B	Entering the Cell Reference

	Placing Labels on the Spreadsheet
	Closing the Spreadsheet
	Entering Values into the Spreadsheet
	Entering Formulas into the Spreadsheet
	Adding Labels to Formulas
	The Value of a Spreadsheet
	Other Types of Formulas
	Saving the Spreadsheet
	Printing Spreadsheets
	A	Gridlines and Headings
	B	Page Setup
	C	Print Preview

	Erasing the Contents of a Cell
	Spreadsheets Exercise 1-1
	Spreadsheets Exercise 1-2
	Spreadsheets Assignment 1

	Formatting Cells
	Formatting Single Cells
	Formatting Groups of Cells
	Formatting Values to Currency
	Formatting Values to Per Cent
	Changing Column Widths
	A	Entering the Required Width
	B	Manually Adjusting Column Widths
	C	Automatic Column Widths

	Approaches for Entering Spreadsheets
	A	Starting a New Workbook
	B	Adjusting Column Widths
	C 	Entering the Labels and Values of the Spreadsheet
	D	Entering the Formulas
	E	Wrap Text
	F	Formatting Non-Adjacent Cells
	G	Underlining Using Borders
	H	Entering the Main Headings
	I	Centring Across Selection
	J	Setting the Font, Sizes and Colours
	K	Adjusting the Row Height
	L	Checking the Spreadsheet
	M	Saving and Printing

	Spreadsheets Assignment 2

	Further Formatting
	Formatting the Values
	Formatting the Table Headings
	Formatting the Main Heading
	The Format Painter Tool
	Adding Borders
	A	Using the Borders Icon
	B	The Draw Border Tool

	Fill Colours
	Column Widths
	Saving and Printing
	Spreadsheets Exercise 3
	Printing Formulas
	Spreadsheets Assignment 3  

	Copying Cell Data
	Fill Right
	Fill Down
	Autofill
	Autofill Options
	Fill Series
	Filling Common Items
	Clearing Cells With Autofill
	Flash Fill
	A	Loading the Prepared Workbook
	B	Extracting Data
	C	Combining Data

	Absolute and Relative Cell References
	A	Loading the Prepared Workbook  
	B	Entering the Formulas

	The Grocery Store Template
	A	Opening the Prepared Workbook
	B	Autofilling the Month Headings
	C	Entering the Month Formulas
	D	Copying the Formulas
	E	Adding Borders
	F	Entering the Totals Formula
	G	Saving and Printing
	H	Making Some Changes

	Spreadsheets Assignment 4

	Rearranging Data
	Loading The Prepared Template
	Saving the Document
	Inserting Rows or Columns
	Editing Cell Contents
	Sorting
	A	Sorting on Labels
	B	Sorting on Values

	Spreadsheets Assignment 5

	Using Worksheets
	Loading a Prepared File
	Saving the Workbook
	Naming a Worksheet
	Copying Data to a New Worksheet
	Changing the Data in the New Worksheet
	Copying a Worksheet
	Moving a Worksheet
	Changing the Sheet Tabs Displayed
	Moving Through Worksheets
	Deleting Worksheets
	Setting Tab Colours
	The Equation Dump
	A	Copying a Worksheet
	B	Turning on the Formulas
	C	Turning on the Headings and Gridlines

	Spreadsheets Assignment 6

	Displaying Data in Charts
	Loading the Spreadsheet
	Creating a Pie Chart 
	The Chart Icons
	Setting the Chart Title
	The Chart Location
	Looking at The Chart	
	Adjusting the Size of the Chart
	Adjusting the Chart Values
	The Chart Elements
	A	Adjusting the Chart Title
	B	Adjusting the Chart Area
	C	Adjusting the Legend	

	Changing the Chart Type
	Exploding a Slice from the Pie Chart
	Changing Slice Patterns
	Looking at Other Chart Types
	Printing Charts
	Deleting a Chart
	Spreadsheets Assignment 7

	More Detailed Charts
	Recommending a Chart	
	The Column Chart Options
	A	The Chart Title
	B	Moving the Legend
	C	The Axis Titles
	D	Data Labels
	E	Data Table

	Setting the Chart Location
	Looking at the Column Chart
	A	The Column Chart Elements
	B	Changing the Plot
	C	Changing the Axes Format
	D	Altering Column Effects
	E	Altering Background Textures
	F	Looking at Other Bar and Column Charts

	Line Charts
	A	Inserting a Line Chart
	B	Altering Line Formats
	C	Changing the Axis Scales

	Other Charts
	Looking at the Charts
	Comparing Values
	Filtering Chart Data
	Spreadsheets Assignment  8

	Sparkline Charts and Quick Analysis
	Loading the Spreadsheet
	Inserting Sparkline Charts 
	Formatting Sparkline Charts
	A	The Sparkline Styles
	B	The Sparkline Options
	C	Sparkline Types	

	Changing the Data
	Copying Sparkline Charts
	Quick Analysis Tools
	Creating Map Charts
	A	Loading the Spreadsheet
	B	Creating the Map Chart

	Spreadsheets Assignment 9

	The Drawing Tools 
	Opening the Prepared Template
	Creating the Logo
	A	Inserting a Text Box
	B	Adjusting the Text Box Shading

	Centring the Text	
	Importing Graphics
	Setting the Graphics Properties
	Magnifying the Screen
	Printing the Spreadsheet
	The Shape Tools
	A	Creating Shapes
	B	Inserting Word Art
	C	Adding Text to Shapes
	D	Fill Effects

	Inserting Icons
	The Draw Tab
	A	Pens and Highlighter
	B	Ink to Shape
	C	Ink to Math

	Spreadsheets Assignment 10

	Module 1 Project
	EasyTune

	Making Predictions With Excel
	The Motel Template 
	A	Loading the Template
	B	Calculating the Income From Rooms
	C	Calculating the Income From Food
	D	Calculating the Total Daily Income
	E	Using the Spreadsheet to Make Predictions

	Adjusting the Motel Template
	The Goal Seek Command
	Applying the Goal Seek Command
	Spreadsheets Exercise 11
	Spreadsheets Assignment 11

	Making Decisions With Excel
	The IF Command
	Greater Than or Equal To
	Exercise 12-1
	A	Completing the Template
	B	Displaying the Formulas Used

	AND and OR
	A	AND (a,b)
	B	OR (a,b)

	Exercise 12-2
	Conditional Formatting
	A	Setting a Conditional Format
	B	Changing Values
	C	Adding Another Conditional Format
	D	Removing Conditional Formats

	Spreadsheets Assignment 12

	Lookup Commands
	Interest Rate Calculations
	A	Loading the Template
	B	Calculating the Interest Due

	Income Tax Calculations
	A	Loading the Template
	B	The Base Tax Calculation
	C	The On Income Calculation
	D	The Extra Income Calculation
	E	The Tax Rate Calculation
	F	The Extra Tax Calculation
	G	The Total Tax Calculation
	H	The Net Income Calculation
	I	Using the Tax Table
	J	The Equation Dump

	Spreadsheets Assignment 13

	Creating Sales Invoices
	Entering the Labels of the Invoice
	Adding Borders
	Creating the Company Title
	Entering the Calculations
	A	Initial Settings
	B	Calculating the Amount
	C	Turning Zero Values Off
	D	Calculating the Sub-Total
	E	Calculating the GST
	F	Calculating the Overall Total
	G	Inserting Today’s Date
	H	Checking the Invoice

	Using the Invoice
	Adding an Inventory to the Invoice
	A	Loading the Template
	B	Looking up the Description
	C	Looking up the Unit Price
	D	Setting the Blank Invoice
	E	Setting the Print Area
	F	Saving as a Read-Only File
	G	Using the Stock Inventory

	Exercise 14-1
	A	Loading the Invoice
	B	Naming the Stock Table
	C	Looking up the Description
	D	Looking up the Unit Price
	E	Turning Off Zero Values
	F	Calculating the Amount and Sub-Total
	G	Calculating the GST
	H	Calculating the Total
	I	Setting the Print Area
	J	Data Validation
	K	Saving as a Read-only File
	L	Using the Invoice
	M	Displaying the Formulas

	Spreadsheets Assignment 14

	Sharing Data Between Files
	Naming Single Cells
	Entering Formulas Using Names
	Naming Groups of Cells
	A	Loading the Template
	B	Naming the Cells
	C	Entering the Formula

	Another Advantage of Named Cells
	Deleting Names
	Linking Spreadsheets
	A	Loading the Outdoors Template
	B	Entering the Formulas
	C	Naming the Cells

	Setting up the Home Department File
	Setting up the Electrical Department File
	The Dependent Spreadsheet
	A	Loading the Office Template
	B	The Net Profit Formula  
	C	The Percentage Profit Formula
	D  	The Totals Formula
	E	Linking the Spreadsheets

	Changing Values in a Support Spreadsheet
	Looking at all the Files
	Spreadsheets Assignment 15

	Using Macros and Buttons
	Using a Simple Discount Table
	A	Opening a Sample File
	B	Setting a 5% Discount Macro
	C	Setting a 10% Discount Macro
	D	Setting a No Discount Macro
	E	Using the Macros

	Saving the File as a Macro-Enabled File
	Assigning Buttons to Represent Macros
	A	Drawing the Shape
	B	Formatting the Shape
	C	Setting the Button Properties
	D	Assigning a Macro to the Shape
	E	Adding Buttons for the Other Macros

	Other Macros and Buttons
	A	The New Items Macro and Button
	B	The Sort Items Macro and Button

	Looking at the Macro Steps
	Deleting a Macro
	The Developer Tab
	Spreadsheets Assignment 16

	Payroll Systems
	Loading the Payroll Template
	Completing the Payroll Worksheet
	The Tax Calculation
	Calculating the Net Pay
	Printing the Payroll
	The Pay Advice Worksheet
	A	Naming the Payroll Cells
	B	Sorting The Payroll
	C	Completing the Name Section of the Pay Advice
	D	Completing the Pay Advice Table
	E	Completing the Superannuation Section
	F	Printing the First Pay Advice
	G	Printing the Pay Advice for Other Employees

	Using the Payroll System
	Adding Macros and Buttons
	A	The first Employee Macro	
	B	Setting a Button
	C	Creating Buttons for the Other 3 Employees
	D	The 3 Remaining Employee Macros
	E	Saving the File as a Macro-Enabled Workbook

	Spreadsheets Assignment 17

	Financial Applications
	Personal Banking 
	A	Opening the Prepared Template
	B	Completing the Formulas
	C	Using the Personal Finances File

	The Home Loan Simulator
	A	Opening the Prepared Template
	B	Entering the Initial Values
	C	Naming the Cells
	D	Calculating the Monthly Interest
	E	Calculating the Number of Repayments 
	F	Setting the Monthly Repayment
	G	Completing the Months Column
	H	The Start Balance Column
	I	The End Balance Column
	J	Turning Zero Values Off
	K	The Monthly Payment Column
	L	The Principal Remaining Column
	M	The Total Paid Column
	N	Completing the Start Balance Column
	O	Adding a Border After Each Year
	P	Using the Simulator

	Spreadsheets Assignment 18

	Date Calculations
	Creating a Library Book Overdue System
	Opening the Prepared Template
	Naming the Book List
	Looking up the Book Title and Author
	Calculating the Return Date
	The Overdue Calculation
	Filling the Formulas
	Using the Library System
	Creating the Equation Dump
	Spreadsheets Assignment 19

	Pivot Tables
	Loading the Prepared Data
	Creating a Pivot Table
	A	Setting Up the Pivot Table
	B	Inserting the Rows, Columns and Data

	Formatting Pivot Tables
	A	Pivot Table Styles
	B	General Formatting

	Editing the Pivot Table
	A	Adding Extra Fields
	B	The Field Options
	C	Turning Sub-Totals Off
	D	Changing the Calculation

	Pivot Charts
	Timelines
	A	Loading the Prepared File
	B	Inserting a Recommended Pivot Table
	C	Using the Timeline

	Spreadsheets Assignment 20

	Useful Tools
	The Save Options
	Conditional Formatting
	A	Data Bars
	B	Conditional Formatting Rules

	Style and Table Formats
	Custom Styles
	The Currency Button
	Filtering With Table Slicers
	A	Creating the Table
	B	Inserting the Slicers
	C	Using the Slicers

	Spell Checking
	Using Touch Mode
	Using Templates

	Module 2 Project
	Quantum Electronics


